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Abstract 

Rationale: Matrix-assisted laser desorption/ionization-mass spectrometry imaging (MALDI-MSI) is routinely 

employed to monitor the distribution of compounds in tissue sections and generate 2D images, whilst 

informative the images do not represent the distribution of the analyte of interest through the entire organ. The 

generation of 3D images is an exciting field that can provide a deeper view of the analyte of interest throughout 

an entire organ. 

Methods: Serial sections of mouse and rat lung tissue were obtained at 120 µm depth intervals and imaged 

individually. Homogenate registration markers were incorporated in order to aid the final 3D image 

construction. Using freely available software packages, the images were stacked together to generate a 3D image 

that showed the distribution of endogenous species throughout the lungs. 

Results: Preliminary tests were performed on 16 serial tissue sections of mouse lungs. A 3D model showing 

the distribution of phosphocholine at m/z 184.09 was constructed, which defined the external structure of the 

lungs and trachea. Later, a second experiment was performed using 24 serial tissue sections of the left lung of 

a rat. Two molecular markers, identified as [PC (32:1)+K]+ at m/z 770.51 and [PC (36:4)+K]+ at m/z 820.52 

were used to generate 3D models of the parenchyma and airways respectively. 
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Conclusions: A straightforward method to generate 3D MALDI-MS images of selected molecules in lung tissue 

has been presented. Using freely available imaging software, the 3D distributions of molecules related to 

different anatomical features were determined. 

 

Keywords:  

MALDI-MSI, Image J, lungs, 3D, lipids. 

 

Introduction 

Imaging techniques such as computed tomography (CT), magnetic resonance imaging (MRI) and positron 

emission tomography (PET) are commonplace in modern medicine, they are routinely used to provide 

anatomical information for diagnosis of diseases such as cancer1. These techniques are capable of non-invasive 

three-dimensional (3D) imaging by generating several 2D images of an organ which are rendered into a 3D 

model. Combinations of these techniques such as CT-PET or MRI-PET can be used to provide more information 

by viewing the data from different modalities together in a 3D model2. However, these techniques are targeted 

and therefore provide limited molecular information. 

Matrix-assisted laser desorption/ionization-mass spectrometry imaging (MALDI-MSI) has been extensively 

used to generate two-dimensional (2D) images showing the distribution of drugs, lipids peptides and proteins 

in tissue sections. However, this does not necessarily represent the distribution of a molecule throughout the 

entire organ. Expanding this technique with the addition of a third dimension would enable a detailed, 

volumetric visualization of these analytes in an entire organ could bridge the gap between molecular and medical 

imaging techniques. 

There are currently two approaches used for generating 3D images with mass spectrometry imaging (MSI), 

depth profiling and serial-sectioning. In the depth profiling approach, ablation of the sample surface is 

performed exposing lower layers for analysis. This approach has been reported using secondary ion mass 

spectrometry (SIMS) to generate 3D images of single cells by monitoring the distribution of two endogenous 

species (adenine and phosphocholine) the nucleus and cell membrane could be visualized respectively3. Laser 

ablation electrospray ionization (LAESI) is also capable of this type of analysis and has been used to visualize 

various metabolites in the leaves of a zebra plant4. 

In order to visualize the distribution of molecules throughout an entire organ the serial-sectioning approach is 

used. In this approach, the sample is cut into serial sections and each section is imaged and then combined into 

a 3D model. This methodology has primarily been reported using matrix-assisted laser desorption/ionization 

(MALDI), the first report visualized the distribution of the myelin basic protein (MBP) in the corpus callosum 

of a mouse brain. The sample was sectioned into a total of 264 tissue sections from which 10 sections were 

selected at equal intervals and analyzed by MALDI-MSI. Optical images of all the sections were then used to 

create a 3D volume of the corpus callosum, the MALDI-MS images were then rendered into the 3D volume5.  

Mouse or rat brains are the most commonly used specimens to visualize due to their size and the availability of 

anatomical/histological references, which can be used to co-register with the MALDI-MS images. Later 
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examples monitored the 3D distribution of peptides and proteins in the substantia nigra and interpeduncular 

nucleus6, proteins have also been visualized in a mouse brain tumor which were co-registered with MRI data7, 

lipids associated with traumatic brain injury8 and recently lipids in medulloblastoma metastasis9. The 3D 

distribution of peptides and lipids has even been visualized in a crab brain10. Ambient ionization techniques 

such as desorption electrospray ionization-mass spectrometry imaging (DESI-MSI) have also been used to 

investigate the 3D distribution of lipids that make up the white and grey matter in mouse brain11. 3D imaging 

has also been shown to be a useful technique to help better understand the molecular make-up of tumor tissue 

and to better define the boundaries between the different tissue types12,13. This is due to the heterogeneous nature 

of tumor tissue, which cannot be accurately represented in a single tissue section. The quantitative 3D imaging 

of chemotherapeutic agents in tumor tissue has also been demonstrated14. 

As the previous examples demonstrate 3D imaging with mass spectrometry imaging is becoming more widely 

applied due to its ability to help with complex tissues and to better understand diseases. This widespread 

application is also being facilitated by the development of faster commercial instruments and software15,16. 

The aim of the work reported here is to develop methodology to monitor the three-dimensional distribution of 

endogenous species throughout the lungs using MALDI-MSI. Serial sections were obtained at 120 µm depth-

intervals through the control mouse lung tissue and imaged individually, homogenate registration markers were 

incorporated in order to aid the final 3D image construction using freely available software. 

 

Methods 

Information 

Healthy mouse lung tissue was obtained from a control batch of tissue, however the strain could not be verified. 

All animal studies were ethically reviewed and carried out in accordance with UK Animals (Scientific 

Procedures) Act 1986, European Directive 2010/63/EU and the GSK Policy on the Care, Welfare and Treatment 

of Laboratory Animals. Healthy rat lung tissue (Wistar Han) was obtained from a control group of rats sacrificed 

for a study on colonic anastomotic healing. The experimental protocol compiled with the Dutch Animal 

Experimental Act and was approved by the Animal Experimental Committee of Maastricht University Medical 

Centre (DEC number 2014-120). 

 

Materials 

Alpha-cyano-4-hydroxycinnamic acid (CHCA), gelatin from porcine skin (type B) and trifluoroacetic acid 

(TFA) were purchased from Sigma-Aldrich (Gillingham, Dorset, UK). Methanol (MeOH) was purchased from 

Fisher Scientific (Loughborough, Leicestershire, UK). Norharmane (NOR) and chloroform (CHCl3) were 

purchased from Sigma-Aldrich (Zwijndrecht, The Netherlands). Methanol, xylene and ethanol (EtOH) was 

purchased from Biosolve Valkenswaard, The Netherlands). Hematoxylin and eosin Y were purchased from 

Merck (Darmstadt, Germany) and J.T. Baker (Center Valley, PA, USA) respectively. 

 

Tissue Preparation 
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A control mouse lung tissue was embedded in gelatin (100 mg/mL aqueous) and placed into a -80°C freezer10. 

Holes were drilled into the frozen gelatin using a RotaCraft RC12VS mini rotary tool kit (SHESTO Limited, 

Willesden, London, UK) fitted with a 3 mm diameter drill bit. The holes were then filled with control rat lung 

homogenate, which was prepared by adding 500 mg of tissue to a 2 mL tube that contained approximately 50 

glass beads. The tube was then shaken at 4800 rpm for 3 × 60 secs using a mini-beadbeater (Biospec Products, 

Bartlesville, OK, USA). 200 µL of water was added to enable the homogenate to be pipetted into the holes in 

the gelatin block, which was stored on dry ice to immediately freeze the homogenate. These act as registration 

markers for later image reconstruction12. The embedded tissue was then sectioned at a temperature of -20°C 

using a Leica Cryostat (Leica, Wetzlar, Germany) to obtain 12 µm sections at 120 µm intervals, which were 

thaw mounted onto glass slides (Figure S1). 

 

Matrix Application 

The mice lung tissue sections were coated with 5 mg/mL CHCA in 70:30 MeOH: H2O with 0.2% TFA was 

applied using a Suncollect automated pneumatic sprayer (Sunchrom, Friedrichsdorf, Germany) in a series of 

layers. The initial seeding layer was applied at 2 µL/minute and subsequent layers were performed at 3 

µL/minute. The rat lung tissue sections were coated with 7 mg/mL NOR in 2:1 CHCl3: MeOH using the HTX 

TM-sprayer (HTX technologies, Carrboro, NC, USA). The following settings were used temperature 30°C, flow 

rate 0.120 mL/min, velocity 1200 mm/min. 

 

Instrumentation 

Mass spectra and imaging data of mouse lung tissue were acquired in positive ion mode on an Applied 

Biosystems/MDS Sciex hybrid quadrupole time-of-flight mass spectrometer (Q-Star Pulsar-i) with an 

orthogonal MALDI ion source (Applied Biosystems, Foster City, California, USA) and a high repetition 

neodymium-doped yttrium vanadate (Nd:YVO4) laser (5 kHz) (Elforlight Ltd, Daventry, Northamptonshire, 

UK). Image acquisition was performed at a spatial resolution of 150 µm × 150 µm in “Raster Image” mode; 

images were generated using the freely available Novartis Biomap 3.7.5.5 software (www.maldi-msi.org). 

Analysis of rat lung tissue was performed using a Bruker rapifleX MALDI Tissuetyper system (Bruker Daltonik 

GmbH, Bremen, Germany) equipped with a Nd:YAG laser (10 kHz). The instrument was operated in reflectron 

mode in the mass range of m/z 400-1000. The instrument was calibrated prior to analysis using red phosphorus 

clusters17. The laser power was 80% with an accumulation of 100 shots. Images of the whole tissue sections 

were acquired using a 50 × 50 μm raster (25 × 25 μm beam scan area). The images were generated using the 

FlexImaging version 5.0 software (Bruker Daltonik GmbH). 

Confirmation analysis in the form of tandem mass spectrometry (MS/MS) measurements were performed on a 

Waters MALDI HDMS Synapt G2-Si mass spectrometer (Waters Corporation, Manchester, UK) equipped with 

an neodymium-doped yttrium aluminium garnet (Nd:YAG) laser (1 kHz). The laser power was 200 arbitrary 

units and the ions of interest were fragmented by collision induced dissociation (CID) in the trap cell with an 

isolation window of approximately 3 Da (defined by the quadrupole low and high mass resolution in the 

http://www.maldi-msi.org/
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instrument control software). High mass resolution measurements (100,000 at m/z 500) were performed using 

on a Bruker solariX Fourier transform ion cyclotron resonance (FTICR) mass spectrometer (Bruker Daltonik 

GmbH, Bremen, Germany) equipped with a 9.4 T superconducting magnet and Nd:YAG laser (2 kHz). The 

instrument was operated in positive ion mode in the mass range m/z 100-1000.  

 

Data processing 

Images of selected masses generated in BioMap 3.8.0.4 software (https://ms-imaging.org/wp/biomap/) were 

exported in the JPEG format (File → Export → Image). Images of selected masses generated in FlexImaging 

5.0 software (Bruker Daltonik GmbH) were copied to the clipboard. Using Microsoft PowerPoint (or available 

image processing software) the images were aligned using the fiducial markers as a guide, the images were 

cropped to ensure they were all the same size and saved in the JPEG format.  

Using Image J 1.46r software (http://rsbweb.nih.gov/ij/), the individual images of the airway or parenchyma 

were opened in order and stacked together (Image → Stacks → Images to Stack). For visualization and 

presentation purposes, two of each image was opened to double the amount of sections. The stacks were then 

saved in the TIFF format. Once the images stacks were generated, they were converted into a 3D model that 

can be freely manipulated (Plugins → 3D → 3D viewer).  In the 3D viewer, a second stack was added (File → 

Add content → from file). The transparency of the parenchyma was adjusted in order to better view of the 

airways. To do this, the parenchyma stack was selected (Select → check the tick box for the parenchyma stack) 

and the transparency was adjusted to the desired value (Edit → attributes → change transparency). Movies 

showing 360° views of the two 3D models was recorded in the 3D viewer window (View → Record 360 deg 

rotation), 

Mass spectral post-processing and recalibration was performed using mMass software18.  

 

Histological staining 

Hematoxylin and eosin (H&E) staining was performed on a rat lung tissue section post imaging. Following 

analysis, the tissue section was immersed in 100% MeOH for 30 seconds to remove the matrix. The sample was 

then washed with a series of solutions (1 × 100% EtOH, 2 × 95% EtOH, 2 × 70% EtOH and deionised water 

for 2 minutes each). The sample was then stained with hematoxylin for 3 minutes and subsequently washed 

with running tap water for 3 minutes. The tissue section was then stained with eosin for 30 seconds and then 

washed again with running tap water for 3 minutes. After staining the sample was placed into 100% EtOH for 

1 minute, following this the tissue section placed in xylene for 30 seconds. After drying at room temperature, 

glass coverslips were placed onto the stained tissue section using Entellen mounting medium. A Leica Aperio 

CS2 (Leica Biosystems Imaging, Vista, CA, USA) was then used to acquire images of the stained tissue section. 
 

Results and Discussion 

One of the challenges of 3D MALDI-MS imaging is that it requires the preparation of high-quality tissue 

sections. The frozen tissue sample is sliced into serial sections, tissue tearing, rolled-up edges and deformations 

https://ms-imaging.org/wp/biomap/
http://rsbweb.nih.gov/ij/
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can make the correlation of consecutive images difficult19. The preparation of lung tissue sections is challenging 

due to fragile parenchyma, often resulting in badly damaged tissue sections. In order to overcome this lung 

tissue is often inflated with embedding media in order to produce high quality tissue sections for MALDI-MS 

imaging20. Gelatin was chosen to externally embed the control mouse lung tissue because it preserves the 

integrity and morphology of the tissue, also gelatin provides less mass spectral interference than optimal cutting 

temperature (OCT) embedding media usually used for cryosectioning10,21.  

Once the embedding and sectioning method had been optimised, the next step was to obtain the molecular 

profiles of the tissue sections and registration markers. The MALDI-MS spectra obtained from the control 

mouse lung tissue and registration markers are shown in Figure 1. 

 

 

A region of interest was drawn on the control mouse lung tissue and on one of the registration markers; the 

corresponding peak list was exported in text format and imported into the freely available mMass software18. 

The mass spectra (obtained from the two regions) were displayed in pairs by flipping one of the spectra as 

shown in Figure 2. In the case of both regions there is an abundance of possible lipid fragments such as choline 

at m/z 104.07, lysophosphatidylcholine (LPC) at m/z 496.33 and phosphocholine at m/z 184.08, which is the 

most abundant peak in both regions. The MALDI-MS spectra also show the presence of possible intact 

phospholipids in the range of m/z 700-800, the most abundant species in this region at m/z 734.55 and m/z 756.56 

were tentatively identified as phosphatidylcholines (PC). In order to confirm the identity of the lipids MS/MS 

and accurate mass measurements were performed. Annotated MS/MS spectra of the selected endogenous 

species are shown in the supporting information (Figure S2A-I). High mass resolution accurate mass 

measurements were also performed to further confirm the molecular identities, these data are shown in Table 

S1. The MS/MS spectra were compared to those in the literature and databases such as lipid maps 

(www.lipidmaps.org) or the ALEX123 lipid calculator (www.alex123.info)22.  

Proper lipid identification is important in order to better understand the changes in lipid expression associated 

with different diseases, however it is challenging due to the complex nature of biological tissues. Measurements 

performed with high resolution mass spectrometers (FTICR) can provide better mass accuracy (~1 ppm), which 

can the provide an elemental formula that enables more accurate lipid database searches. However, these 

measurements can only provide the sum composition of the fatty acids chains and cannot differentiate between 

isomers.  

In order to provide more information, tandem mass spectrometry (MS/MS) measurements are performed. The 

most abundant information gathered from MS/MS measurements in positive ion mode is related to the 

headgroup of the lipids. In the case of phospholipids, the most common peak that observed is that of 

phosphocholine at m/z 184. However other information can confirm if the lipid is protonated, sodiated or 

potassiated by monitoring peaks related to the headgroup cyclic 1,2-phosphodiester of phospholipids at m/z 125, 

147 or 163 respectively23,24. Other peaks at m/z 60, 86 and 104 representing trimethylamine, dehydrated choline 

and choline are also related to the phospholipid headgroup but are present regardless of the ion type. 

http://www.lipidmaps.org/
http://www.alex123.info/
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Corresponding peaks related to the neutral loss of the trimethylamine (-59 Da), phosphocholine headgroup (-

183 Da) and sodiated or potassiated phosphocholine (-205 and 221 Da respectively) are also observed (Figures 

S2F, G and H). 

MS/MS measurements can also determine the identity of the two fatty acid chains present in the lipid molecule, 

which was demonstrated with the peak at m/z 734.54 (Figure S2F). Two peaks at m/z 478.31 and 496.31 were 

observed, which corresponds to the neutral loss of palmitic acid or 16:0 (-256 Da) and ketene (-238 Da). As 

only two peaks were observed, it was determined that this was the phosphatidylcholine [PC (16:0/16:0)+H]+. 

However, in the case of lipids with different fatty acid chains, the position of the fatty acid chains (termed sn-1 

and sn-2) and position of double bonds cannot be determined with high resolution or MS/MS measurements. 

Using techniques such as ozone-induced dissociation (OzID) coupled with mass spectrometry imaging, it is 

now possible to obtain this information. It has also been demonstrated that isomeric lipid species have distinct 

distributions in biological tissues25,26.Following profiling, MALDI-MS imaging was performed on a consecutive 

tissue section (adjacent tissue sections collected in between those used in the 3D model) in order to determine 

the distribution of the observed molecular species. The MALDI-MS images of selected ions related to molecular 

species are displayed in Figure 2. 

 

 

The MALDI-MS images (Figure 2) show the distribution of various endogenous species throughout the control 

mouse lung tissue. From these data it can be seen that choline at m/z 104.07 (Figure 2A) is localised in specific 

regions of the tissue section and phosphocholine at m/z 184.08 (Figure 2D) is distributed throughout the control 

mouse lung tissue section. Other species included LPC related peaks such as [LPC (16:0)+H–H2O]+ at m/z 

478.32 (Figure 2F), [LPC (16:0)+H]+ at m/z 496.33 (Figure 2G), as well as the sodium and potassium adduct at 

m/z 518.33 and  543.33 (Figures 2H and 2J respectively). The ions at m/z 734.55 and 756.56 were identified as 

[PC (32:0)+H]+ and its sodium adduct [PC (32:0)+Na]+ (Figures 2K and 2L respectively). These species have 

been previously identified to be molecular markers for the parenchyma of the lung27. The images obtained, show 

that these species are also widespread throughout the lung tissue sections. Interestingly, the distribution of the 

selected molecular species appear to be influenced by the type of ion (protonated or cationized). This is observed 

in the images of protonated species (Figure 2B, D, F, G, I and K), which appear to be homogenously distributed 

throughout the lung tissue section. In contrast, sodiated and potassiated species (Figure A, C, E, H, J and K) are 

more localized in the parenchyma. All of the selected species were also observed in each of the homogenate 

registration markers located in the four corners of the images.  

The generation of a three-dimensional image was performed by serially sectioning the mouse lung tissue with 

defined and measured spatial intervals (z-dimension), a total of 16 sections were collected and analyzed by 

MALDI-MSI. Phosphocholine at m/z 184.08, which was the most abundant lipid species, was chosen to show 

the structure of the lung tissue. The resulting 2D MALDI-MS images of the sixteen images generated showing 

the distribution of phosphocholine in the control mouse lung tissue are presented in Figure 3. 
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The 3D reconstruction of the distribution of phosphocholine at m/z 184.08 generated using the Image J software 

is shown in Figure 4 and is displayed from different angles. 
 

 

The 3D MALDI-MS images showing the distribution of phosphocholine at m/z 184.08 (Figure 4) is displayed 

from different angles. The images show that phosphocholine is widely distributed and only shows the external 

structure of the control mouse lungs, however the images clearly display trachea and the right and left lobes. 

Following the evaluation of the method, the left lung of a rat was prepared in the same manner as the previous 

sample and cut into 24 sections. Upon analysis two species that defined the parenchyma and airways were 

detected, which were identified as [PC (32:1)+K]+ at m/z 770.51 and [PC (36:4)+K]+ at m/z 820.52 respectively. 

The individual images of the two species are shown in Figures S3 and S4 respectively, also the localization of 

these species in relation to histological features is presented in Figure 5. The hematoxylin and eosin (H&E) 

stain of the last tissue section in the stack post imaging (Figure 5A) shows the presence of the airways with 

blood vessels in close proximity, which are surrounded by the parenchyma. The MALDI-MS image of the 

parenchyma marker (Figure 5B) shows this is homogenously distributed but is absent from the airways and 

blood vessels. In contrast, the airway marker (Figure 5C) is located in the parenchyma but is elevated in the 

airway walls. The overlay (Figure 5D) clearly demonstrates the complementarity of these two species.  

 

 

Previously identified species related to both the airways and parenchyma were also present in the data sets but 

were not used for the construction of the 3D models27. The 3D MALDI-MS images of the parenchyma and 

airway markers are shown in Figure 6.  

 

 

The 3D MALDI-MS images (Figure 6) were constructed following alignment and viewed from different angles. 

The 3D MALDI-MS images of the parenchyma (Figure 6A) defines the shape of the lung. The 3D MALDI-MS 

image of the airways (Figure 6B) shows the presence of the large airways that further divide into smaller airways 

towards the periphery of the lungs. The overlay of the two 3D models (Figure 6C) shows the airways embedded 

within the parenchyma and further demonstrates how complementary the selected endogenous species are 

together (see videos 1-3 in the supporting information).  Both species were also present in the fiducial markers 

around the tissue, however as observed in Figures S2 and S3, the fiducial markers are absent in later sections. 

This is due to air bubbles that can form when adding the homogenate into the drilled holes, which when frozen 

results in broken or missing fiducial markers. Should this happen the individual images can be aligned using 

the optical image as a guide. 
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Conclusions 

The work presented here describes a method for monitoring the three-dimensional distribution of endogenous 

species in the lungs of a mouse. Control mouse lung tissue was serially sectioned resulting in 16 tissue section 

obtained at defined intervals, these sections were individually analyzed. Later another 3D model was 

constructed using a control rat lung, which was prepared in the same manner. Here two molecular markers, 

identified as ([PC (32:1)+K]+) and ([PC (36:4)+K]+) that defined the parenchyma and airways respectively were 

used. The addition of registration markers enabled straightforward image alignment, then utilizing Image J 

software the individual MALDI-MS images which showed the distribution of a specific endogenous species 

were stacked together and viewed as a 3D image.  

Whilst the serial sectioning method requires careful sample preparation and is time consuming, the methodology 

could potentially be used to monitor the distribution of inhaled drug formulas in the lungs or endogenous species 

associated with respiratory diseases. Quantitation of compounds in individual tissue sections could be performed 

using previously reported methods29. 
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Legends to Figures and Tables 

 

Figure 1: MALDI-MS spectra obtained from the control mouse lung tissue (blue spectrum) and the registration 

markers (red spectrum). The annotated peaks were confirmed using MS/MS and high mass resolution 

measurements and later visualised. 

Figure 2: MALDI-MS images showing the distribution of various endogenous species in the control mouse 

lung tissue section. A) choline at m/z 104.07, B) phosphocholine fragment at m/z 124.9, C) phosphocholine 

fragment at m/z 162.1, D) phosphocholine at m/z 184.08, E) [LPA (18:1)+Na]+ at m/z 459.32, F) [LPC (16:0)+H–

H2O]+ at m/z 478.32, G) [LPC (16:0)+H]+ at m/z 496.32, H) [LPC (16:0)+Na]+ at m/z 518.32, I) [LPC (18:0)+H]+ 

at m/z 524.33, J) [LPC (16:0)+K]+ at m/z 534.33, K) [PC (16:0/16:0) + H]+ at m/z 734.55 and L) [PC (16:0/16:0) 

+ Na]+ at m/z 756.56. Spatial resolution 150 × 150 µm, normalized with protonated CHCA matrix peak at m/z 

190.05. 

Figure 3: 2D MALDI-MS images showing the distribution of phosphocholine at m/z 184.08 following 

normalization against the protonated CHCA matrix at m/z 190.05, throught the 16 control mouse lung tissue 

sections. 

Figure 4: 3D MALDI-MS images produced using Image J software showing the distribution of phosphocholine 

at m/z 184.08 following normalization against the protonated CHCA matrix at m/z 190.05, throughout the 

control mouse lung tissue from different angles. 

Figure 5: Correlation of molecular markers with histological staining. A) Hematoxylin and eosin (H&E) 

staining of lung tissue post imaging. MALDI-MS images showing the distribution of B) parenchyma marker 

([PC (32:1)+K]+) at m/z 770.51, C) airway marker ([PC (36:4)+K]+) at m/z 820.52 and D) overlay of selected 

molecular markers. Spatial resolution 50 × 50 µm, normalized with TIC as indicated by the red “T” in the top 

right corner based on reporting nomenclature28. 

Figure 6: 3D MALDI-MS images of the parenchyma and airways. 3D MALDI-MS images showing the 

distribution of A) [PC (32:1)+K]+ at m/z 770.51 that highlights the parenchyma and B) [PC (36:4)+K]+ at m/z 

820.52 that highlights the airways. C) Overlay of the parenchyma and airway 3D models (transparency of the 

parenchyma stack set to 12%). 
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Figure 6 

 

 
 

 

 

 


